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Sometimes it’s better to
renovate, and sometimes it’s
better to take down the old
house and build a new one in its
place. In the upcoming release 4
of the popular RootsMagic gene-
alogy software, the structure will
look familiar, but inside the walls
the house will be humming.

RootsMagic prime developer
Bruce Buzbee, who will speak to
the Silicon Valley Computer Ge-
nealogy Group at the November
8 meeting, got so enthused
about the new build of the soft-
ware that he started a blog
(blog.rootsmagic.com) in July.
Post by post, he has announced
new features that will emerge in
RootsMagic 4, due for release by
the end of 2008. Thousands of
curious RootsMagic users follow
each announcement.

Buzbee will unveil the re-
lease to SVCGG at the Novem-
ber 8 meeting, 9 am. to || am,
at the Quince Avenue chapel in
Santa Clara, California. (See
directions on the back page, and

at www.svcgg.org.)

“We've never had an up-
grade anywhere near this big,”
Buzbee explains. “This is an or-
der of magnitude bigger than any
previous upgrade.” The devel-
opment team has been working
on the upgrade for three years.

“What I'm working on right
now is the last of the reports,”
Buzbee explains. “Then fixing

bugs that the beta testers have
found—we’ve had our beta test-
ers hammering on it.” Finding
and fixing bugs is standard for
any new software release, and is
an indication that the functional-
ity of the software is being
tested thoroughly before it is
released to the public.

Buzbee’s presentation No-
vember 8 will provide several
firsts for the users group. Not
only will it be the first look at
the new release of RootsMagic,
but it will be the first demon-
stration of how the new genera-
tion of genealogy software will
interface with the newFam-
ilySearch program being rolled
out in geographic increments by
The Church of Jesus Christ of
Latter-day Saints (LDS).

The newFamilySearch pro-
gram incorporates the various
databases held by the LDS
Church into a pedigree struc-
ture built by the users. It has
been opened to LDS members
by geographical area for testing
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and development, and will be-
come available to the public.
Major genealogy software pack-
ages such as RootsMagic are be-
ing configured to interact di-
rectly with newFamilySearch.

The new release of Roots-
Magic, which has involved a
complete rewrite of the soft-
ware, will include innovative fea-
tures in a familiar look-and-feel
environment. Not only is
RootsMagic 4 being written in a
different programming language
than prior versions, but it also
employs a new database engine.
It also will be possible for devel-
opers to write tools for Roots-
Magic 4. These changes will
“allow more flexibility down the
road,” says Buzbee.

After 18 years of genealogy
software development, Buzbee
says he is getting a feel for what
will excite users. For example,
RootsMagic 4 will provide DNA
support for both mitochondrial
and Y chromosome informa-
tion—a change users find excit-

Adding New Magic to RootsMagic

ing, even though relatively few
are likely to use it. Another
new feature will be “shared”
events, or witnessed events,
which can be added to multiple

_| persons but not necessarily ap-
= plied to an entire family.

Some changes are designed
just to make the program easier
to use, such as changes in the
print preview process of report
generation. Users will be able
to email a report directly with
the click of a button from inside
the program. Additionally, the
program will create PDF or rich
text files for attachment to
email, without the users having
to know how to generate those
types of files. This feature will
be popular with “a big chunk of
users,” Buzbee predicts.

Other features include Uni-
code support, and a shareable
CD feature that allows the soft-
ware to run from a CD without
requiring software installation.
This popular feature also was in
version 3.

Buzbee and his team of pro-
grammers have been working
long days to wrap up the final
tweaks to the release. In the
final weeks before the release,
Buzbee will continue to use his
blog somewhat like an advent
calendar, to tantalize users with
final announcements of what
may be the most popular fea-
tures.
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A Big Chart for a Big Family

By Richard D. Rands

Yosemite National Park in California is a mighty big place, and
this summer it held what was a mighty big event for our family.
The event was my parents’ bi-annual family reunion, at Curry Vil-
lage in Yosemite. In spite of nearby forest fires that obscured the
magnificent cliffs some days, we hiked, ate, toured, ate, watched
wildlife, ate, and...ate.

| wanted to create a chart that would illustrate dramatically the
size of my parents’ family, which includes 153 descendents. My
parents had six children, and each of those children has at least five
children. (One of my sisters has |3 children.) Since this may turn
out to have been the last time we gather this many members of
the family, it was especially important to give my parents some-
thing that would make them proud of their achievement.

Of all the charts used by genealogists to represent descen-
dents, the most impressive may be the drop-line chart—the one
that shows all the children of a generation on a horizontal line be-
low their parents and each succeeding generation on a horizontal
line dropped down below that line. However, with 41 grandchil-
dren plus 41 spouses all on one generational line, the software
programs | looked at would have produced a chart so long that it
would have been unmanageable.

| needed to compress the space between all the names of a
given generation so that the chart would be small enough to
spread out in a living room, but large enough that the names could
be read easily. My goal was to create something that everyone
could sign, as a memento of the reunion. Furthermore, it would
have been fruitless to create a permanent record on expensive
material, since at the time | created it, three more great-great-
grandchildren were on the way, with the likelihood of many more
descendents to follow.

After some inquiries, | settled on using Microsoft PowerPoint,
for several reasons. | use PowerPoint frequently for presentations,
it has fairly easy-to-use charting tools, and it also can scale the size
of a chart to large proportions. Also, | knew that a number of
print shops, such as FedEx Kinkos, could electronically stitch to-
gether several PowerPoint screens and inexpensively print the re-
sult as one long banner. | knew it would take some work to manu-
ally create the chart in PowerPoint, but | was confident that the
end result would have the desired impact of displaying an impres-
sive posterity in a compact space.

The first step was to review the information about all the de-
scendents in my family history database, and to make certain that |

Lorraine Rands with
her chart on the inside
of the garage door

had the latest information. | contacted every family, making certain
that | had everyone’s correct birth dates and places, marriage dates
and places, and middle names. That step had the auxiliary benefit of
bringing the family database up-to-date.

Meanwhile, knowing that the largest size chart that PowerPoint
will support is 56 inches wide and 56 inches high, | calculated that |
would need to stitch together three slides to accommodate a gen-
eration with 82 names. After making a rough layout of the overall
chart, | determined which names would appear on each of the
three slides. | then created a standard template for the individual
names that included the person’s full name, birth date, marriage
date, and death date. | selected the Andale font (used by PAF),
which was readable but compact, and began building the chart.

For each family, | put the children in chronological order from
left to right. | found myself becoming far more knowledgeable
about my grand-nephews and grand-nieces, finally sorting out
which ones belonged to which nephews and nieces. The hardest
part was to get the horizontal lines connecting families together to
match perfectly between the three slides, so that they would
match when they were stitched together. Because | had open
space at the top of the chart, | added four generations of my par-
ents’ direct-line ancestors, which gave the chart depth.

One problem caused a few days of extra work. | used Power-
Point 2003 to create my slides, but | then found that my local
FedEx Kinkos had only PowerPoint 2007 on their system. When
they converted my slides to version 2007, the font spacing
changed, and some of the lines were not aligned. | had to use my
wife’s computer with PowerPoint 2007 to resize most of the
boxes to accommodate the different font spacing, and realign some
of the lines.

The printing staff then stitched the three slides together, con-
verted the file to a PDF, and printed it out on a banner printer.
The result was a spectacular chart that spanned 14 feet and only
cost me a bit over $30 (not counting at least a week’s work).

On the final evening of the reunion, we spread the chart out on
several tables, had everyone sign their name under their box on
the chart, and presented it to my parents. One of the great-
grandchildren exclaimed that he had no idea he was related to so
many people. Some family members reminisced over family mem-
bers who had died. When my parents returned home, they
mounted it on the inside of their garage door and added some
color. Everyone who visits their home is treated to a spectacular
view of my parents’ posterity.




November-December 2008

SILICON VALLEY PASTFINDER

PAGE 83

Splder Webs: Tennessee Death Records, Irish Collections

Tennessee Death Records

Death records for the State of Tennes-
see are now available online. Registrations
of births and deaths began in 1908 in Ten-
nessee. The Tennessee State Archives and
Library Web site has created an index that
covers nearly 98,000 deaths occurring in
Tennessee between 1908 and 1912. The
index includes all extant records, but some
early deaths may have been missed because
the deaths were not registered as carefully
and regularly as they were beginning in
1914.

Included in the index are the name of
the deceased, county and year of death,
and certificate number. When no year of
death is given on the certificate, it is re-
corded in this index as "1908-12". Death
records for the year 1913 were not re-
corded in Tennessee. Children with no
given name are listed as "infant". Death re-
cords in this time period do not give par-
ents' names. They do include the individ-
ual's age, occupation, place of birth and
cause of death. The index information can
be used to order a copy of the death cer-
tificate from the Tennessee State Library
and Archives. The Tennessee death re-
cords for 1908-1912 are found at: www.
tennessee.gov/tsla/history/vital/death2.htm.

Tennessee deaths from 1914 to 1926
are available on the state government Web
site at www.tennessee.gov/tsla/history/vital/
tndeath.htm. The Statewide Index to Ten-
nessee Death Records is in the beginning
stages. The state plans to index all Tennes-
see death records for the years 1914 on-
ward. This index includes the name of de-
ceased, county of death, and volume and
page number of the certificate. When or-
dering a death record from this index, one
should include all of this information.

The Memphis Public Library History
and Genealogy Index Web site at http:/
tempo.memphislibrary.org/dadabik/
program_files/sform.php contains the
Memphis/Shelby County Death Index
(1848-1945). This index includes deaths
within Memphis and Shelby County which
were recorded in the Memphis Death Reg-
ister Books beginning in 1848; the Memphis
Burial Permits 1902-1913; and Memphis/
Shelby County Death Certificate Card In-
dex, 1914-1945. Entries include the name,

date of death, age, gender, and race of the
deceased, and the source record. This index
also includes people who died in Memphis
but who were buried elsewhere, and those
whose bodies were brought back from an-
other location for burial. Also included is a
list of licenses granted to ship bodies
through Memphis, and the Yellow Fever
Deaths Index (1878), which includes all indi-
viduals in Memphis who died in the 1878
Yellow Fever Epidemic. Entries in the latter
index includes the death date, full name, race
and address.

The Shelby County, Tennessee, Archives
has all Tennessee deaths from 1949 to 2005
on their Web site. The index includes the
full name, date of death, age, county in which
they died, county in which they resided,
marital status, gender, race, and a link to a
request form to get the death certificate.
This Web site also has death records for
Shelby County from 1848 tol957. The death
certificate can be viewed or printed for free
from this site. Go to: http://register.shelby.
tn.us/

Irish Collections

Familyrelatives.com has made a large col-
lection of Irish records available online. The
records are part of their plan to add more
than 10 million new records by the end of
this year. Included in the new records are:
Indexes to Irish Wills 1536-1857 (5 Vol-
umes), Irish Genealogical Guide, Quaker Re-
cords Dublin Abstracts of Wills, Alumni Dublin-
ense 1593-1846, Ireland Topographical Diction-
ary, Land Records Ireland, Commissioned Sea
Officers of the Royal Navy, 1660-1815, Irish
Names and Surnames, MacDonald’s Directory —
5 counties and the Medical Register for Ireland
2 Volumes. The Irish Genealogical Guide - Cop-
ies & Abstracts of Irish Wills contains informa-
tion copied from original wills by genealo-
gists before an act of vandalism destroyed
four court buildings in Dublin on 30 June
1922. The original copies of many Irish wills
were destroyed in the fire, as well as many
other important documents. The copies and

abstracts were collected after the disaster.

Familyrelatives.com describes the re-
cords as follows:

“Indexes to Irish Wills 1536-1857 (5 Vol-
umes), this dataset is a five-volume series
of indexes to Irish wills. Each entry lists the
individual's name, address, and the year the
will was settled in probate.

“Irish Genealogical Guide, copies and Ab-
stracts of Irish Wills covers the period
from 1445 to 1834. Each entry lists the
individual's name, address, reference and
the year the will was settled in probate.

“Quaker Records Dublin Abstracts of Wills.
The Abstracts include valuable information
including the individual's name, address, and
the year the will was settled and proved in
probate. Family relations, occupations, wit-
nesses, freeholds, monies, inventories and
more are mentioned in the abstracts.

“Alumni Dublinense 1593-1846.
Amongst other material includes schools,
school alumni, the individual’s name, fa-
ther’s name, trade, profession, or rank, age,
birthplace, and the year they were awarded
their degree.

“The Royal School, Armagh
The Royal School, Armagh register officially
began in 1849 although records date back
to 1635.

“Ireland Topographical Dictionary. The
database is an alphabetical dictionary of the
topography of Ireland and provides histori-
cal and statistical descriptions of several of
Ireland's counties, cities, boroughs, corpo-
rate markets, post towns, parishes, and
villages. A useful resource as they enable us
to locate and learn about the places our
ancestors lived. provides historical and
statistical descriptions of several of Ire-
land's counties, cities, boroughs, corporate,
market and post towns, parishes, and vil-
lages. [lt is an] Ideal source for learning
about the place your ancestors lived.

“Return of Owners Land Ireland 1876.
The Return shows the holding, in acres,
roods and poles, and estimated yearly
rental valuation, of all holdings over | acre.
The database is organized by county, land-
owner and address for each landowner is
provided.

“MacDonald’s Directory 1927 for the
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counties of Antrim, Tipperary, Armagh, Belfast, Londonderry and
Kerry. Business and trade directories providing useful social his-
tory information on trade names and occupations, names, ad-
dresses as well as information on schools in the locality.

“Irish Names and Surnames, a fascinating collection of Irish
names and surnames, the records include the Gaelic names of
men and women from English to Irish and Irish to English and Clan
names with useful and historical descriptions and the origins of a
name, a treat for budding onomatologists.

“Medical Register for Ireland 2 Volumes. The records contain
the surname, address and location, year and qualifications followed
by the Medical Schools from which the Members qualified.
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“Irish Passenger Lists 1846-1851, Passengers who arrived at the
Port of New York during the Irish famine are already available for
free online.”

All these records are available to those who subscribe to
Familyrelatives.com. For those engaged in Irish family history re-
search, the subscription price is a bargain. Over the next few
months the site will add more Military records including Commis-
sioned Sea Officers of the Royal Navy, 1660-1815, and School and
University records for England, Wales, Scotland, including Ireland
and the USA.

To visit the site, go to: www.Familyrelatives.com

Finding a Smith Family

A Case History of the Search for Descendents of Chauncey Smith

By Allin Kingsbury

My third-great-grandfather had a daughter who married
Chauncy Smith of Stafford, Tolland County, Connecticut. They are
mentioned in Kingsbury Hall: The Genealogy of a Family, by Kenneth
J. Kingsbury, which is the most recent and most accurate geneal-
ogy of the Kingsbury family. It says that Chauncey Smith was born
on |16 April 1824 in Stafford and married his wife Susan on 8 Sep-
tember 1847 in Stafford. The only other fact about him in the
book is that he was a farmer.

The descendents of all the other children in the family had
been traced. |, for the love of a good challenge, decided to find the
descendents of Chauncey Smith. Also, before doing any library
research, | planned to find as much on the Internet as could be
found before looking at microfilm or printed sources at libraries. |
reasoned that | could find the family in the U.S. census starting
with 1850, where their first children would be listed by name.

An online search of the 1850 U.S. Census listed Chauncey and
Susan Smith with their first child, Nelson T. Smith, born in 1848.
The 1860 and 1870 census returns listed six additional children.
Two more children who died in infancy were listed in a family tree
posted on the Internet.

Ancestry World Tree (Ancestry.com) has a family tree which
included the Chauncey Smith family. It does not include the par-
ents of Chauncey, but includes much of the family of his wife,
Susan, whose family appears in several publications and which |
already had in my database. The online family tree has exact birth
dates of all the children, including three additional children who
died young and did not appear in the census. This information
made the total number of children to nine. The family tree gave
no information about spouses of the children of Chauncy, nor did
it list any of his grandchildren. | tentatively accepted the birth
dates of the children as correct because names and dates were
consistent with the census returns. One discrepancy was a child
listed as Henry in the tree, but listed as Harry in each census.

There was a more serious discrepancy in the family tree. A
death date for Chauncey’s wife, Susan, of 9 January 1880 was in-
cluded. She was alive when the 1880 census was taken, living with
her son Harry (age eleven), but Chauncey had died after the last
child was born in 1872 and before the 1880 census, which was
taken on 29 June|880. | believe the 1880 death date is for

Chauncey, not Susan, but this is one of a number of discrepancies
| did not resolve using the Internet.

After many frustrating searches, | found Susan in the 1900 cen-
sus, living with her son, Harry in Rockville, Connecticut. Harry
was married and had two children. When the 1910 census was
taken, Harry had moved to Ellington, Connecticut, and the family
had grown to four children. Susan was not with the family. She
would have been about 80 years old.

With a name as common as Smith, it is almost impossible to
verify that children found living away from their parents are the
correct individuals. Census data are unreliable and there is little
information other than age, state where they are born, and birth-
places of parents found in the 1880 and later censuses. With a
name like Smith, a search may find several individuals who match
the search criteria. When the individuals are living with already
known close relatives, and if the data are consistent in two or
more censuses, we have a much stronger argument that the chil-
dren are the individuals that we are seeking. After more frustrat-
ing searches, | found the four other living children in Massachu-
setts. Clifton was in Longmeadow, married, but without children.
Edward was in North Brookfield with his wife and one child, plus
two children from an earlier marriage. | then found the first wife
in the 1880 census. Frederick was listed in the 1900 census living
in Greenfield, Massachusetts. Nelson appeared in the 1880 census
with his wife and a daughter. | searched for the three of them in
the 1900 and 1910 censuses and could not find any of them.

In the 1910 census, Edward Smith and his wife, Carrie were
living with ElImer Varnum and his wife, Elizabeth. They had been
married six months. Elizabeth was the daughter of Edward by his
first wife. The 1920 and 1930 census records listed five children
for this family.

The Connecticut Death Index lists the maiden name of the
deceased and the name of the spouse, making it possible to con-
nect individuals into families. | found a record of Esther Cavanagh
(nee Esther Smith) who died 30 December 1995 at Vernon, Con-
necticut, and who was born 17 September 1907. Her husband was
Robert Cavanagh. The information was found searching for Esther
Smith, one of six daughters of Chauncey Smith’s son, Harry, who
resided in Vernon. The search was for Esther, born 1907, and
mother’s maiden name of Smith. The birth date matched. They
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were in the 1930 census living in Massachusetts with two children.

The eldest son in this family was Robert B. Cavanagh. A search
for him using Google found an obituary for James Michael
Cavanagh, an optician who died in Tolland, Connecticut, on 13
May 2008. His parents were listed as Robert B. Cavanagh and
Helen Gorman. The Social Security Death Index confirmed the
relationship, listing Robert B. Cavanagh, born 21 January 1928 and
died I'| August 2001 in Rocky Hill, Hartford, Connecticut. Also
listed in the obituary are three brothers: Robert; William of San
Louis Obispo, California; and Timothy (wife Valerie) of Portland.
Another brother, John, was stated as previously deceased. Three
sisters were also mentioned: Maureen Brown (husband Robert) of
Tolland, Paula Hollister (husband David) of Vernon, and Patricia
Anderson (husband Craig) of Enfield.

The Connecticut Marriage Index had the following:

Robert P. Cavanagh of Ellington, age 21, married Marga E.
Williamson of Ellington, age 20, married 31 August 1974 in
Tolland

Paula A. Cavanagh of Vernon, age 23, married David W. Hol-
lister of Vernon, age 32, married |1 Apr 1927 in Ellington

The Social Security Death Index listed the following:

James M. Cavanagh, born 5 Jun 1955, died 13 May 2008,
Rocky Hill, Hartford, Connecticut

Helen Cavanagh, born 21 Jan 1929, died 21 Aug 2007, Coven-
try, Tolland, Connecticut

Robert Cavanagh, 21 Jan 1928, born 21 Jan 1928, died || Aug
2001, Tolland, Tolland, Connecticut

| almost wished for a few more deaths in this family because
the obituaries are so helpful.

Others in the third generation of Chauncey Smith’s family
were traced using similar sources and strategys on the Internet. |
am sure | have not found all the members of this family, but the
research has produced 73 members of the Chauncey Smith family.
I have a list of searches to do on the Internet, but they are be-
coming more time consuming and more likely to end in failure. |
could go to microfilm or make a trip to the Salt Lake Family His-
tory Library now and find more of the information, or | could be-
gin contacting living individuals now and would expect to gather
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more information. It may be that | cannot find all of Chauncey’s
descendents due to the current court decisions on privacy and
the reluctance of family members due to fear of identity theft. The
thrill of the chase kept me going, and | am amazed that | was able
to find as much as | did on the Internet.

The Internet tools for research provide added difficulty in re-
search. The census data available from Ancestry.com is a powerful
research tool. | was frustrated because the indexer wrote the sur-
name as Smitt. The cursive writing looked like Smith to me. That
caused many extra searches for me. Another problem in Ancestry
is that the results are not ranked. A birth date that is off by one
year is treated the same as a birth off by 50 years. A name mis-
spelled with one vowel wrong is ranked equally with a name dif-
fering by several consonants. Each search engine is different, and
one should know the limitations of the search. | thought that the
name Smith would be much more difficult than it actually was. For
one thing, the name is familiar, and is seldom misspelled like other
less common names. Because Smith is common, middle initials are
often used in the names, and these are usually correct.

You may wonder if | have made any errors in connecting the
information into families. It is possible, especially considering the
many pages of Smiths that show up as possible hits in each search.
However, most of the connections were verified with a second
and sometimes a third piece of corroborating evidence. In addi-
tion, | usually looked for and noted individuals with similar names
and birth dates who could be mistaken for the individual for
whom | was searching, and | attempted to account for that person
to eliminate them as a possibility. | also was not satisfied until |
had filled in all the blanks that could possibly be completed. | al-
ways looked for death dates when | had a birth date. | always
searched the World War | draft records if the individual was eli-
gible for military service. | always looked in all the applicable cen-
sus records to locate where an individual lived. Some records may
only yield a small bit of information like a middle name, but that
information may prove to be crucial, in a later step in the re-
search.

Few of you, if any, are related to this Smith family, but the
techniques and strategy are universally applicable. | hope this case
study will be of help for those who encounter similar research
problems. | hope you all are successful in your research.

SOftware Of InterESt: FamViewer for iPhone and iPod Touch

Aster Software announced its new genealogy software, Fam-
Viewer, that allows genealogists to carry their genealogy databases
with them on their iPhone and iPod Touch. FamViewer imports
GEDCOM files and displays them on the iPhone. GEDCOM files
may be uploaded to FamViewer using a Web browser on a desk-
top or laptop computer or downloaded to FamViewer directly
from a Web site or Web server using WiFi. The contents of the
imported GEDCOM file are displayed by FamViewer, including
individuals, families, notes and sources. Users can navigate the
family tree with a touch.

An index by surname allows the user to find any individual in
the database. A family view, resembling a family group sheet, dis-

plays three generations of a family with children, parents, and
grandparents. A touch of a parent's name brings to view details of
life events and personal attributes. Each event and attribute can
have sources and notes, which can be read in another view.

All the FamViewer views can be seen in portrait or landscape
orientation. Long names, places, dates, and other data can be eas-
ily viewed. FamViewer is not limited to any desktop genealogy
software. All good genealogy programs can export GEDCOM
files, which make the programs compatible with FamViewer.

FamViewer can be purchased at the Apple store and sells for
$14.99. More information is available at: www.astersoftware.biz




PAGE 86

Of Interest

tory Expos

Open the Irish Republic 1926 Census

The Council of Irish Genealogical Organization's (CIGO) has
been campaigning to open the Irish Republic's 1926 Census. This
is an important record for those seeking ancestors born in Ireland
before the start of civil registration in 1864. The organization has
gathered approximately 1000 signatures, but need many more.
The organization encourages those who will sign the petition to
do so at the campaign Web site at: www.petitionspot.com/
petitions/1926C

Palatine Special Interest Group

The Ontario Genealogical Society has established a Special
Interest Group for Irish Palatines. They will have the same status
as a Branch but are not limited to a geographical area. OGS now
has 31 Branches throughout the Province of Ontario, including the
Irish Palatine Group.

The Palatines were Protestants who left the German Palati-
nate in 1709 and were invited by Queen Anne of England to settle
in various British colonies. A group of 185 families settled in Ire-
land. Shortly after 1830, many of the Irish Palatines began moving
to Canada. Many Canadians have Irish Palatine ancestry, and are
often unaware that they have ancestors from this group.

Anyone interested in this SIG should e-mail SIG-IP@ogs.on.ca.
Glasnevin Cemeteries in Ireland to Build Museum

Work has begun on a new €12 million ( $15 million) museum
and visitor center located at Glasnevin Cemetery in Dublin, Ire-
land. It is the primary Catholic cemetery in the capitol city of Ire-
land and has been operating continually for 176 years. The state-
of-the-art building is expected to open in the spring 2010 and will
house an underground museum and over 1.5 million archived bur-
ial records beginning when the cemetery opened in 1832. The in-
novative project, which is being funded entirely by the cemetery
owners and operators, Glasnevin Cemeteries Group, is to com-
plement ongoing restorative work at the Cemetery that began in
May 2007 under the direction of the Office of Public Works
(OPW). The Glasnevin Cemetery Visitor Center, designed by
award winning architects A & D Wejchert, will house 20,300
square feet of facilities and will be covered by a curvilinear roof.
Part of the building will include an innovative underground mu-
seum, called The Crypt, located under the information center, di-
rectly over the original culvert or drainage system that predates
the cemetery. The pipes and vats of the drainage system will be
visible through a glass floor in the Crypt Museum.

The underground museum will include touch-screen access to
over |.5 million burial records. An exhibition area will house in-
teractive displays which will follow themes from Ireland’s turbu-
lent history. A few of the suggested exhibits include:

Foundation of the modern Irish state
Daniel O’Connell — “The Liberator”
The 1916 rebellion

Famine, cholera, smallpox, and pestilence outbreaks
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Open the Irish Republic 1926 Census, Palatine Special Interest Group, Glasnevin Cemeteries in Ireland
to Build Museum, New Confucius Genealogy Out Next Year, My Ancestors Found Is Now Family His-

The museum will also provide new and improved facilities for
the visiting public and staff at the cemetery. They include a restau-
rant and indoor seating areas for people who wish to visit the
graves of their loved ones. The first floor will house conference
rooms, The Daniel O’Connell Lecture Hall, Glasnevin Cemeteries
Committee boardroom, staff offices and facilities.

As part of the ongoing restorative work in association with
the OPW, the Glasnevin Cemeteries Group are integrating with
the Botanical Gardens and Tolka Valley Linear Park to create a
beautiful park of over 200 acres. The combined park will be the
second largest green space amenity in Dublin City, second only to
the Phoenix Park.

New Confucius Genealogy Out Next Year

The genealogy of Confucius, the famous Chinese philosopher
and educator who lived from 551-479 B.C., has the distinction of
being the longest family tree in the world, according to the Guin-
ness Book of Records. Four editions of this family tree have been
published. in 2009, the Confucius Genealogy Compilation Com-
mittee (CGCC) will publish the fifth edition of the Confucius Gene-
alogy. It will be a large work containing several volumes. The his-
tory of the family spans a period of more than 2,500 years and
includes more than 80 generations. It has taken ten years to com-
pile this latest list of descendants of Confucius.

In 1998 Kong Deyong, a 77th-generation descendant, as head
of the World Federation of Confucius Descendants, organized a
committee in Hong Kong to update the family tree. More than
450 branches of the committee were set up around the world to
assist in the work.

The fifth edition contains more than 1.3 million new entries
that were not in the previous edition which was published in
1937. The dead get into the publication at no charge, but living
descendants have to pay five yuan (70 US cents) to be included in
the new edition. Since the 1937 edition contained 600,000 descen-
dants, the new edition will contain a total of more than two mil-
lion descendants.

The fifth edition will break with tradition. For the first time,
women, members of national minorities, and overseas descen-
dants will be included in the genealogy. The Chinese tradition of
assigning a lesser rank to women is said to have originated with
Confucius.

My Ancestors Found Is Now Family History Expos

My Ancestors Found has organized and sponsored family his-
tory and genealogy events. The name of the organization has re-
cently been changed to Family History Expos, perhaps to better
described their mission. The organization has been successful with
the events that it has sponsored and hopes to continue offering
quality events.

The Web site includes the following features:

e  Family History Expos Genealogy Podcast includes interviews
by DearMYRTLE of Expo speakers, sponsors, and exhibitors.

e  Family History Expos Genealogy Blog has news of upcoming
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Expos and discusses the possibility of new locations to be Found newsletter, which will discuss family history products
considered for an Expo. and services, announce events, and share research advice and

e  Family History Expos TV is coming soon with online videos tips from family history professionals.

from multiple interviewers/sponsors who partner with Family e  Family History Expos’ Online-store sells items related to fam-
History Expos. ily history.

e Expo News is an extension of the previous My Ancestors You can visit their new Web site at: www.FamilyHistoryExpos.

sk the _Joc — | Give No Answers Before Their Time!”

3. If you have access to a copy of PAF Insight, you
can use the Check/Repair feature in PAF Insight,
which is known to have a more rigorous repair
— capability. Your local Family History Center might
= have PAF Insight.

How do | put a GEDCOM on a CD rather

5 than a floppy disc? | have Windows XP and

-~ keep getting a message that it is the wrong applica-
= tion.

How can | print the relationship indicators in
PAF?

The only way | know how to do that in PAF

5.2 is to create a custom report. When you
select the fields to be printed on your report, the
Relationship Indicator is one of the fields you can
specify for printing. For example, if you want to
print out a list of all of your ancestors in relation-
ship order, you can go to the Custom Report rou-
tine and select your ancestors. Then when you
choose the fields to be listed, include the Relationship Indicator
and make it also the sort field.

Since most genealogy software does not contain the neces-
sary drivers to export files directly to a CD, you will have
to write your GEDCOM to your hard drive and then use the CD

| received a message that my PAF file is damaged. What can | Write routine built into Windows XP to put it on the CD.

© .
do to recover it! Here are the steps to do it:

The solution depends on the message and the way in which |

ved it Export your GEDCOM to a folder on your hard drive or
you received it.

send it to your Desktop (and remember where you put it)

There is a Check and a Check/Repair feature in the File menu
for PAF that will run through your database and look for prob-
lems with the internal structure of the database. You can runitin 3. Right click on the Start button and select the Explore option.
Check only mode to see what the errors are. Then you can run it
again in Check/Repair mode to see if the errors can be repaired.

If it says the errors have been fixed, then run it again to make sure

that they disappear. Sometimes the repair process creates new 5 Nayigate to the CD Drive and use the Edit menu to Paste the
errors, so it might take more than one run through the program. GEDCOM file. You will now see the GEDCOM file appear
on the right side of the screen as having been copied to the
CD. But it has not yet been written to the CD. It is only
marked to be copied after you decide you have copied all the
files you want on the CD.

N

Put a CD in the drive on your computer.

Navigate to the folder where you saved the GEDCOM file on
your hard drive and use the Edit menu to Copy it.

If the errors are too egregious, then the repair process will
not be able to repair them. In that case, you have several other
options:

I. Restore from a backup that was created prior to the damage.
This is not my favorite solution, because it will usually over-
write changes you have made since that backup was created.
The Check/Repair routine will recommend this option, but |
consider this as the very last resort.

With the CD drive selected (highlighted), click on the File
menu and select Write these files to CD. You will be asked
to enter a name for the CD. Click “Next.” When the file(s)
have been written to the CD, the drive will eject the CD.

2. Create a full GEDCOM of your database, and then reload the /- You Will be asked ,',f you want to make another copy of the
GEDCOM back into a new empty file, which will allow the CD. Click “Finish.
PAF Import routine to rebuild the internal structure of the When | print reports to file and save in RTF, the saved file is
database without the damage. This is a good solution providing not in the format of the report. All the data runs together
the damage does not get exported into the GEDCOM file. on one line and several line draws appear under the text.
When you export the GEDCOM file, watch the screen as it is
writing the file to make sure it doesn't tell you there are er- Because the RTF format is specifically for printing, it is nec-
rors. Then when you reload (Import) the GEDCOM into a essary to view the file using the Print Layout view in your
new empty file, watch for error messages as well. Check the ~ word processor. Assuming you are using Microsoft Word, pull
counts of Individuals, Marriages, Notes, and Sources before down the View menu and select the Print Layout option. That

and after to make sure the same number of records came back should apply all the printing layout specs to your screen layout.
in that were written.
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